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Big Ideas

Designing for the web is different than designing other types of software.

Why? What’s the difference?

• Infinite complexity
• No boundaries
• No beginning – no ending

• Who is the user? How can you be sure?
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Goals & Audience

Consider designing an automotive parts website & an interaction 
design portfolio website.

??How advanced are their 
computer skills?

??What are their 
goals?

??What kind of 
vocabulary do they 

use?

??What is their domain 
knowledge?

??Who is your intended 
audience?

??What is the purpose of your 
website?

Interaction 
Design Portfolio

Automotive 
Parts
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Theme

ashford.com

Who is the intended audience?

How can you tell?

What is the goal of the website?

What is the goal of the user?
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Theme

alloy.com

Who is the intended audience?

How can you tell?

What is the goal of the website?

What is the goal of the user?
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Theme

marthastewart.com

Who is the intended audience?

How can you tell?

What is the goal of the website?

What is the goal of the user?
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Theme

Which theme is most 
successful?

What makes it 
successful?

Which is least 
successful?

Why?

Theme is the emotional 
quality produced by the 
content, layout, colors
and style of a site.
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Navigation

Rules of thumb:

People have no clue where they are on a website

People have no clue how they got where they are 
on a website

People generally “wander around” on the web, 
totally confused about what’s going on

Why? What is it about the world wide web 
that is so disorienting for people?
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Navigation : Common Elements
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Navigation : Common Elements
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Navigation : Common Elements
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Navigation : Site Maps
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Navigation : Site Maps

4 steps to a successful site map:

1: Brainstorm the content that the site will 
have, using sticky notes. Write one piece of 
content on each sticky note; put the notes 
on the wall.

2: Organize the sticky notes into logical 
groupings, based on the content of the 
notes (not on preconceived notions of what 
the groupings should be)

3: Within a grouping, stack-rank the content 
based on priority. Merge content that is 
very similar.

4: Create a visual tree to show how content 
relates to the groupings. 
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Navigation : Site Maps : Let’s Do One

Create a site map for an online, multi-disciplinary design firm.

What types of content will live on the site?

What section names make sense for this content?
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Navigation : Takeaways

Assume your users are lost

Provide a map, but assume they won’t use it

Give your users as many navigation cues as possible  

Select a navigation scheme that relates to your intended audience
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Technical Overview 

Packets of data, 
being sent over the 
phone line, cable, 
cellular, etc.

Internet Service Provider. 
SCAD, America Online, MSN, 
AT&T ..

Routers & Servers. 
Scattered all around the 
world.

(More people 
looking at porn)

Root Server. 13 of 
them in the world.

You, at home, 
looking at porn.
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Typical Web Design Process

Executives make a 
strategic decision 
and assign a new 
project 

$$
$$

A single designer 
does lots of good 
research, process, 
drawing, and 
prototyping and 
creates several 
photoshop screens  

A team of software 
developers spend 
many months 
implementing the 
screens

The designer 
is sad 
because the 
end result 
looks nothing 
like what was 
intended, but 
there is no 
time to fix it. 
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Typical Web Design Process

How can we fix this?

The “backend” of a website is the 
stuff that makes it work.
The “frontend” of a website is the 
stuff that the user interacts with.

Our goal is to never let the 
software developers touch the 
frontend. 

We do this by learning markup.

IDUS315 - Human Computer Interaction | 20

Agents & Browsers: What They Do

What is markup?
To understand markup, we need to understand agents. 
What is an agent?

Your web browser is an Agent.
Your cellphone is an Agent.
Your tv can be an Agent.

An Agent is a program that accepts data from a webserver
and attempts to display it.

All web pages are just data.

Markup informs the agent about the data, enhancing it.
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Agents & Browsers: What Markup Looks Like

If your code looks like this:

This is some data 
without markup. It’s 
rather plain.

It will print out like this:

This is some data without 
markup. It’s rather plain.

If your code looks like this:

<H1>This is some data 
with markup. It’s 
<strong>really</strong> 
great.</H1>

It will print out like this:

This is some data with 
markup. It’s really
great.
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Agents & Browsers: What Markup Looks Like

<H1>This is some data 
with markup. It’s
<strong>really</strong> 
great.</H1>

Markup:

• Always starts with a less then sign <
• Always ends with a greater than sign >
• Always comes in pairs

<p>   </p>
<strong>  </strong>

Your agent can read various types of 
markup. If it can’t read it, it ignores it.

The same data can then be shown on a 
webpage, a cell phone, and a television set, 
and the agent can format it to suit the 
display.
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Agents & Browsers: Making Markup

Dreamweaver, Homesite, 
goLive, Pagemill and 
Frontpage are software 
packages that write 
markup for you.

But they don’t always do 
a good job.

Software developers are 
people that write markup 
for you.

But they don’t always do 
a good job.

Markup is becoming as 
ubiquitous as English. You 
need to know how to read 
it.
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Agents : Key Points

In theory:
Designers write markup using a common set of guidelines
Browsers (agents) read that markup using a common set of guidelines
The user sees the same thing regardless of which browser they choose
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Agents : Key Points

Older browsers render markup in very, very different 
ways.

Newer browsers are much more flexible about how they 
display your markup.

Internet Explorer, Netscape, WebTV, Konqueror, Mozilla, 
Opera, Mosaic, OmniWeb, Lynx, Voyager, iCab, iBrowse, 
NetCruiser . . .

It is very, very, very hard to force even moderately 
complicated designs to look the same in every browser.

Make an explicit decision about what browsers you intend 
to design for, based on:

• Your audience
• The complexity of your designs
• The purpose of your site
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Languages : Brief Overview

< client servers >

Runs a web browser 
(Internet Explorer, 
Netscape, etc)

Receives the data and 
markup; translates 
that into a visual 
representation (what 
you see on the 
screen).

Runs software called a Web 
Server (Apache, IIS, etc)

Developers write code in Java, 
PHP, Perl, etc.

Application Server compiles code 
and creates a document with 
data and markup.

Web Server serves the data to 
the client upon request.
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Languages : Brief Overview

Java looks like this:
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Languages : Brief Overview

Perl looks like this:
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Languages : Brief Overview

Javascript looks like this:
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Languages : Takeaways

They are all similar
They are scary, but not that scary
If you want to learn them, it’s really not that hard, 
and I will be happy to teach you.

The more technical things you know, the more 
you can do yourself.

If you do it yourself, you know it will be right. 
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Conceptual Web Design

All web pages are 
broken into three 
conceptual sections:

• Content
• Layout
• Function

Our goal is to keep 
these separate.

Why?
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Conceptual Web Design

Up until very recently, content, function and 
layout were not separate.
Most web sites you currently use do not 
separate these items.

The old method was the “table method”.
The new method is the “css method”.

We are going to learn the “css method”. 

You need to understand the tradeoffs of the 
two methods.
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Tables vs. CSS

Tables

+ Can visualize any design you can 
make in Photoshop, regardless of 
complexity

+ Work the same in any web 
browser

- Download very slowly (are much 
bigger)

- Don’t work on any advanced 
agents (cellphones, webTV, digital 
cameras, etc)

- Very hard to update

- Reject the separation of content, 
layout and function

Cascading Style Sheets [css]

- Can visualize moderately 
complicated designs; complex 
designs are very hard to create

- Work differently in various 
browsers

+ Download very quickly (are 
generally quite small)

+ Work very well on advanced 
agents, allowing the content to take 
precedence over layout

+ Incredibly easy to update

+ Embrace separation of content, 
layout and function
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Tables vs. CSS

Cascading Style Sheets [css]

- Can visualize moderately 
complicated designs; complex 
designs are very hard to create

- Work differently in various 
browsers

+ Download very quickly (are 
generally quite small)

+ Work very well on advanced 
agents, allowing the content to take 
precedence over layout

+ Incredibly easy to update

+ Embrace separation of content, 
layout and function

• You need to create much simpler layouts

• Your layouts needs to be lenient and 
forgiving

• You need to give up some control

• You are designing a system, or 
framework, for the visualization 
rather than the visualization itself
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Getting Set Up

1. Create a folder to store your files. (right click => New => Folder)
Call it html.

2. Within the html folder, create two new folders; call one images and the 
other css.
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Getting Set Up

3. Make sure file extensions are not hidden. 
(Tools => Folder Options => View) 

Uncheck this box
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Getting Set Up

4. Within the html folder, create a new text 
document, and call it index.html. 
(Right click => New => Text Document)

5. Open index.html by double clicking it, and it 
opens in Internet Explorer.

6. View the source of the document in Internet 
Explorer (View => Source)
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Getting Set Up

7.  The resulting screen is your code window.

Anything you type in the code window will be 
displayed in the browser.

8.  To see your webpage in the browser, press 
CTRL-S to save, Alt-Tab to switch, and F5 to 
reload.
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Basic HTML Page

Here is a basic webpage:

<html>

<head>

<title>

Your Page Title

</title>

</head>

<body>

<h1>This is a header</h1>

<div>

<P>This is a paragraph</p>

</div>

</body>

</html>
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Basic HTML Page

It’s pretty hard to read, so we use indenting to format the text visually.

<html>

<head>

<title>

Your Page Title

</title>

</head>

<body>

<h1>This is a header</h1>

<div>

<P>This is a paragraph</p>

</div>

</body>

</html>
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Basic HTML Page

The markup describes, or enhances, the content.

<html>

<head>

<title>

Your Page Title

</title>

</head>

<body>

<h1>This is a header</h1>

<div>

<P>This is a paragraph</p>

</div>

</body>

</html>
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Basic HTML Page

The markup describes, or enhances, the content.

<html>

<head>

<title>

Your Page Title

</title>

</head>

<body>

<h1>This is a header</h1>

<div>

<P>This is a paragraph</p>

</div>

</body>

</html>

<h1> .. </h1> defines a Header, 
Level One

<div> .. </div> defines a 
document division, or container of 
content

<p> .. </p> defines a paragraph
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Basic HTML Controls

Chunks of content:

<h1> .. </h1> defines a Header, Level One (most important)

<h6> .. </h6> defines a Header, Level Six (least important)

<div> .. </div> defines a document division, or container of content

<span> .. </span> defines a text division

<p> .. </p> defines a paragraph

Special items:

<img src=“images/imageSource.jpg” /> defines an image with a particular source

<br /> defines a line break

<a href=“newPage.html”> .. </a> defines an anchor, with a hypertext reference to a 
particular page; this is also known as a link!

IDUS315 - Human Computer Interaction | 44

Basic HTML Page Revisited

<html>

<head>
<title>Jon's Homepage</title>

</head>
<body>

<div>
<p>Jon's Page | welcome .. portfolio .. links</p>

</div>
<div>

<h1>welcome to my page</h1>
<h2>Overview</h2>
<p>This is some text discussing the various 

aspects of the page you are currently visiting.</p>
<h2>Portfolio Discussion</h2>
<p>You can view some of my projects, download my 

resume, or contact me</p>
</div>

<div>
<h6>(c)2003 Jon Kolko</h6>

</div>
</body>

</html>

Eek that’s ugly!
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Basic HTML Page Revisited

<html>

<head>
<title>Jon's Homepage</title>
<link rel="stylesheet" href="css/type.css">
<link rel="stylesheet" href="css/layout.css">

</head>
<body>

<div id="headerPane">
<p>Jon's Page | welcome .. portfolio .. links</p>

</div>
<div id="welcomePane">

<h1>welcome to my page</h1>
<h2>Overview</h2>

<p>This is some text discussing the various 
aspects of the page you are currently visiting.</p>

<h2>Portfolio Discussion</h2>
<p>You can view some of my projects, download my 

resume, or contact me</p>
</div>
<div id="footerPane">

<h6>(c)2003 Jon Kolko</h6>

</div>
</body>

</html>
That’s much nicer. How 
did we do it?
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Basic HTML Page Revisited : type.css

<html>

<head>
<title>Jon's Homepage</title>
<link rel="stylesheet" href="css/type.css">
<link rel="stylesheet" href="css/layout.css">

</head>
<body>

<div id="headerPane">
<p>Jon's Page | welcome .. portfolio .. links</p>

</div>
<div id="welcomePane">

<h1>welcome to my page</h1>
<h2>Overview</h2>

<p>This is some text discussing the various 
aspects of the page you are currently visiting.</p>

<h2>Portfolio Discussion</h2>
<p>You can view some of my projects, download my 

resume, or contact me</p>
</div>
<div id="footerPane">

<h6>(c)2003 Jon Kolko</h6>

</div>
</body>

</html>
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Basic HTML Page Revisited : layout.css

<html>

<head>
<title>Jon's Homepage</title>
<link rel="stylesheet" href="css/type.css">
<link rel="stylesheet" href="css/layout.css">

</head>
<body>

<div id="headerPane">
<p>Jon's Page | welcome .. portfolio .. links</p>

</div>
<div id="welcomePane">

<h1>welcome to my page</h1>
<h2>Overview</h2>

<p>This is some text discussing the various 
aspects of the page you are currently visiting.</p>

<h2>Portfolio Discussion</h2>
<p>You can view some of my projects, download my 

resume, or contact me</p>
</div>
<div id="footerPane">

<h6>(c)2003 Jon Kolko</h6>

</div>
</body>

</html>
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Basic CSS control

• Each line that makes up a style sheet is called a "rule". 

body {
background-color: #000000;

}

rule
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Basic CSS control

• Each line that makes up a style sheet is called a "rule".
• Each rule consists of a "selector" and one or more "declarations".

body {
background-color: #000000;

}

selector

declaration
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Basic CSS control

• Each line that makes up a style sheet is called a "rule". 
• Each rule consists of a "selector" and one or more "declarations".
• Each declaration consists of a "property" and a "value”

body {
background-color: #000000;

}

property value
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Basic CSS control

• Each line that makes up a style sheet is called a "rule". 
• Each rule consists of a "selector" and one or more "declarations". 
• Each declaration consists of a "property" and a "value”

body {
background-color: #000000;

}

• A selector can be any html element (img, h1, h2, p, div, body, etc)
These are automatically applied to html.

• A selector can also be a specific, made up name (fred, headerPane, 
navBar, etc). These are not automatically applied to html, unless:

<div id="headerPane">
<p>Jon's Page | welcome .. portfolio .. links</p>

</div>
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Summary

We have achieved separation of layout and content.

<html>
<head>
<title>Jon's Homepage</title>
<link rel="stylesheet" href="css/type.css">
<link rel="stylesheet" href="css/layout.css">   

</head>
<body>
<div id="headerPane">

<p>Jon's Page | welcome .. portfolio .. links</p>

</div>
<div id="welcomePane">

<h1>welcome to my page</h1>
<h2>Overview</h2>
<p>This is some text discussing the various 

aspects of the page you are currently visiting.</p>

<h2>Portfolio Discussion</h2>
<p>You can view some of my projects, download my 

resume, or contact me</p>
</div>
<div id="footerPane">

<h6>(c)2003 Jon Kolko</h6>
</div>

</body>
</html>

content (html) + Presentation (css) = Philosophically 
correct (and 
pretty) webpage
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Summary : Basic HTML Page Again

<html>

<head>
<title>Jon's Homepage</title>
<link rel="stylesheet" href="css/type.css">
<link rel="stylesheet" href="css/layout.css">

</head>
<body>

<div id="headerPane">
<p>Jon's Page | welcome .. portfolio .. links</p>

</div>
<div id="welcomePane">

<h1>welcome to my page</h1>
<h2>Overview</h2>

<p>This is some text discussing the various 
aspects of the page you are currently visiting.</p>

<h2>Portfolio Discussion</h2>
<p>You can view some of my projects, download my 

resume, or contact me</p>
</div>
<div id="footerPane">

<h6>(c)2003 Jon Kolko</h6>

</div>
</body>

</html>
That’s much nicer. How 
did we do it?
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Summary : Basic HTML Page : type.css

<html>

<head>
<title>Jon's Homepage</title>
<link rel="stylesheet" href="css/type.css">
<link rel="stylesheet" href="css/layout.css">

</head>
<body>

<div id="headerPane">
<p>Jon's Page | welcome .. portfolio .. links</p>

</div>
<div id="welcomePane">

<h1>welcome to my page</h1>
<h2>Overview</h2>

<p>This is some text discussing the various 
aspects of the page you are currently visiting.</p>

<h2>Portfolio Discussion</h2>
<p>You can view some of my projects, download my 

resume, or contact me</p>
</div>
<div id="footerPane">

<h6>(c)2003 Jon Kolko</h6>

</div>
</body>

</html>
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Summary : Basic HTML Page : layout.css

<html>

<head>
<title>Jon's Homepage</title>
<link rel="stylesheet" href="css/type.css">
<link rel="stylesheet" href="css/layout.css">

</head>
<body>

<div id="headerPane">
<p>Jon's Page | welcome .. portfolio .. links</p>

</div>
<div id="welcomePane">

<h1>welcome to my page</h1>
<h2>Overview</h2>

<p>This is some text discussing the various 
aspects of the page you are currently visiting.</p>

<h2>Portfolio Discussion</h2>
<p>You can view some of my projects, download my 

resume, or contact me</p>
</div>
<div id="footerPane">

<h6>(c)2003 Jon Kolko</h6>

</div>
</body>

</html>
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